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SchoolFusion Student Guide  
FusionTools 2.0 (Full Guide) 

With Personal Dashboard 2.0 
Audience: Students 

Welcome to your schools (URL) SchoolFusion website. This site was designed to help you get the most out of 
your education. SchoolFusion offers a variety of tools, which may or may not be utilized by your school.  

These tools include interactive classrooms, recent activity emails, a messaging center and Web 2.0 tools such 
as Blogs, Podcasts, Vodcasts and Wikis.  

 

Please use this guide as a reference to navigate the SchoolFusion website.  
User Login: 

Type > Username 

Type > Password  
Click> Submit 

 
Usernames and passwords are case sensitive.  

 
Login information, including username and passwords 

are assigned by school administrators. If you have 
questions regarding this information, please contact 

<Administrator Name> the school directly.  
 

Personal Dashboard 
 

The Personal Dashboard is your personal space within 

the SchoolFusion System. From here you will have 
access to: personal settings, personal calendar, a file 

storage space, and more. This view may be different 
based on the modules that your organization has 

chosen to implement.  
 

At the top you will see “Welcome, Your Name” and 
“A.k.a. Code Name”.  

 

This code name is generated by the system, and is 
based on a color and an animal.   

My Account 
My Account provides links to the following personal areas:  

 Calendar 

 Files 
 Message Center 

 Personal settings 
 

Logn > Personal Dashboard > My Account 

Calendar 
This link combines all your events, meetings and assignments into your personal calendar based on your 
group memberships.  You can also include your personal appointments. Your personal calendar is only visible 

to you.  However, if your parents have been connected to your account, this information will appear on their 

calendar as well.  
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Access My Calendar 

 

Log in > Click My Account > Click Calendar  
 

My Calendar automatically contains events and assignments 
from your classes, clubs, athletic teams, parent 

organizations, and departments, as well as any personal 
appointments you have added. 

 
 Events can be filtered. 

 Months can be selected  
Add to the calendar 

Click > Add Event 

 
Enter an Event Name 

 
1. Choose a Start and End Time. 

2. Type the Date of the Event. 
3. Add a Summary and a Description. 

4. If it is a Repeat Event, choose the length of time 
between repeats and an ending date. 

 

 
Save the Event to the Calendar 

Save to the calendar: Click > Add Event (then view event 

listing). 
OR 

If you want to add another event 
Click > Add Event (then add another). 

 

Edit or Delete Events 

Click > Edit Events on the top tab to open this screen. You 
can edit any events that you have added to your My 

Calendar, but cannot edit any events that have populated 
your calendar based on your FusionPage membership.  

 Click on the Event Name to open and edit.   
 Click > Edit Event to exit. 

 Click > Delete to delete events 
 

Add an iCal Feed 

Click > iCal Feed 
 

To create a URL allowing you to see this calendar from any 
program, which supports iCal feeds, click on the iCal Feed.  

You can copy and paste this into any calendar product that 
supports the iCal format, such as Apple iCal, Google 

Calendar, Windows Vista Calendar, and Outlook with an add-

in. SchoolFusion provides you with a URL that you will need 
to add to your calendar product. 

 
Click > Synchronize Calendar  

Available only in Internet Explorer, you can sync your my 

 
 

 
 

http://www.kennerprice.com/icalendar/
http://www.kennerprice.com/icalendar/
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Calendar with your Outlook Calendar.  

A Wyncs plugin will be installed the first time a calendar is 
synchronized. Wyncs does not work with Windows Vista.  

 
Click > Synchronize Now > Check Events > Click 

Synchronize Now 

 
Files 
The Files link allows you to upload documents to access later. They can be accessed from any computer with 

an internet connection.   
 

File Details - File types not accepted: .exe    Total File storage limit: 15 MB 

Access Files 

Log in > Click My Account > Click Files  
 

My Files link allows users to upload documents.  This is 
considered a personal storage area. Most file types are 

accepted, but there a 15 MB limit for all files stored. 

 
Add File 

Within My Files you can upload documents directly, or you 

may organize your files within folders.  To add a single file: 
 

Click > Add File > Click > Browse > Add a description > 

Click > Upload File 
 

 If files have previously been uploaded, you will see them 
listed here.  

 If folders have been created, you will see them here 
with a description, if it was added.   

 If you want to add the new file to a folder, click on the 
folder before you Click > Add File. Once a file has been 

uploaded, it cannot be moved into a folder.  

 

 

Create a Folder 

Create a folder: Click > Create Folder  

 
Add the Folder Name and Description: Click > Create 

Folder 
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Open a Document 

Open the document after it is uploaded: Click > Document 

Name > Click > Open or Save 
 

 
Delete or Overwrite a Document 

Find the file you wish to delete: Click > Delete 

 
Find the file you wish to overwrite: Click > Overwrite 

 

Next, you will need to Browse for a file to replace this one. 
Click > Browse 

 
Select the file and add a Description:  Click > Upload File 

 

 
My Message Center 
The message center allows you to send and receive messages with your teachers. You do not need to have an 

email address associated with a SchoolFusion Account to use the message center. If you do have an email 
address associated, you will be notified by email when you have received a message, if not you will be 

notified of any new messages anytime that you login to the SchoolFusion site.  

My Message Center 
The Message Center filters messages by user type, both 

student and parent. Message Center will also track sent and 

received messages, in a manner very similar to a traditional 
email client.   

 
Within the Message Center, each message is grouped into a 

conversation view, meaning that all connected messages are 
grouped with the originating message, which enables the 

user to see the complete conversation history. 
 

Inbox 

 
The Inbox shows all messages, bolding unread messages, 

and indicating the date and time that the message was sent.   
Click > Inbox  

 
Read a message: Click > Message  

 

Reply to a message: Click > Message > Type Message 
> Click Send 

 
Delete message(s): Check appropriate box(es) > Click 
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Delete 

 
Compose 

Students can only send messages to teachers. 

Click > Teacher Name 
 

This will take you to the teachers profile page.  
Compose message > Click > Send 

 
Your teacher will be notified of the message once it is sent.  

 
Please note: There is no limit to the length of the message, 

but files cannot be attached to a message.  

 

 

Sent 
The sent page displays all messages that you have sent to 

your teachers. Sent Messages cannot be deleted from the 

sent box.  
Click  > Sent  

 
 

Trash 
This displays all messages that you have sent to the trash 

can.  
Click > Trash 

 
Please note that because state public record laws vary 

between states, SchoolFusion has made the decision that all 
messages must be kept in the Trash and Sent boxes for a 

period of 7 years in an effort to meet all state requirements, 

as we have clients in various states. 7 years is the longest 
retention period. 

 

My Personal Settings 
The My Personal Settings link allows you to update your personal information, notification settings and links to 

all of your FusionPages. 

Click > Account >  Personal Settings 
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Personal Tab 

From the Personal Tab, you may be able to change the 
following information:  

 User Name 
 First Name 

 Last Name 
 Birthday / Phone Number/ Passcode 

 Email Address 
 

Click > Personal Info Tab >Make Updates > Click 

Change Information 
 

Please note: Some schools have locked down the information 
that can be updated. If your information is incorrect, pleases 

contact the school directly. The fields that you are able to 
change will be in boxes.  

 

Change Password 

 
Update your password, enter the following: 

1. New Password 
2. Confirm Password (enter the exact same password as 

you entered in New Password) 

 
Click > Change Password 

  
A message will display at the top of the page confirming that 

your password has been updated. 

 

Daily Activity Notifications 
aka Recent Activit y Email  
 

Click > Daily Activity Notifications > Yes/No > Submit 
 

Daily Activity Notification is an email that all users, including 

faculty/staff and parents, are automatically signed up for. 
This email will contain information regarding all FusionPages 

where you are a member. The email will be sent every 
Sunday through Thursday. The Sunday edition contains 

information regarding information added to the system on 
Friday and Saturday, if information has been entered within 

the proper timeframe. If information has not been entered 
within the proper time frame, a daily email will not be sent.  

 

Any information that is included in the Recent Activity Digest 
email will also be included in a your “Recent Activity” posting 

and any RSS feed. This is available to the user two different 
ways: 

 A “Recent Activity” box displays at the top of your 
SchoolFusion website upon logon. If you choose to hide 

the Recent Activity box, it will only appear once every 
four hours, regardless of the number of times you login 

to the site in that four hour period.  This feature cannot 
be permanently turned off.  
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 A “Recent Activity” link that is available through the 

user’s Personal Dashboard. For parents, this information 
is always available for their children via the “My Family” 

link found in their Personal Dashboard.  
 

The Recent Activity Digest email contains information added 
to the system within the prior 24 hours, and will contain 

information for the upcoming three days. Information must 
be entered into the system by 3:00 pm Mountain Standard 

Time (MST) in order to be included in the Recent Activity 

Email for the day. Information entered after 3:00 pm MST 
will be included in the next days’ Recent Activity Email.  

 
This email could potentially include the following information, 

based on the configuration of your school and the information 
entered by your teachers:  

 Homework assignments 
 Class announcements 

 Class/Group calendar events 
 The addition of new Class/Group files 

 Blog entries by teachers of groups that the user is a 
member of 

 Responses to any comments that the user has posted 

 Grades 

Change Messaging Options 

 
Click > Change Messaging Options > Submit 
 

This allows you to select how you will be notified when a 
message is sent through the SchoolFusion Message Center. 

See the My Message Center section for more information 
regarding Message Center. 

 

The two options are:  
 Receive an email for each message - An email will be 

sent immediately when someone sends a message.   
 Do not receive an email - instead, you may be notified 

of a new message when you log in, as well as your 
nightly Recent Activity Email. 

 
 

 

Set up Daily Digests  
Click > Set up Daily Digests  

 
This email includes information contained within the 

community calendar that belongs to the site where your user 
account lives. You will need to sign up for this email, and 

have three options:  

 Send me a daily "Your School Digest" the day of. 
In this case the email will be sent the day of the event.  

 Send me a daily "Your School Digest" the day 
before. In this case, the email will be sent the day 

before the event. 
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 Do not send me the daily "Your School Digest". 

Edit Newsletter Subscriptions 

This tab allows you to subscribe to any of the Newsletters 
that have been created within your site, and district 

organization.  
 

Click > Edit Newsletter Subscriptions 
 

Subscribe to a Newsletter: Click > Subscribe to 

newsletter topic  
 

Unsubscribe to a Newsletter: Click > Unsubscribe to 
newsletter topic 

 
View all newsletter topics within a district 

organization: Click > View All newsletters in the 

district  

 

 
My FusionPages Tab 

The My FusionPage tab contains a listing of all the Groups, 
also known as FusionPages, where you are a member or 

administrator. 
 

A user can view each FusionPage, but will not see the pencil 
or red x.  Only an administrator can edit or delete a 

FusionPage.  If data synchronization is used by your district 

to create FusionPages, a previously deleted FusionPage may 
reappear on the My Groups list.  Please contact your district 

administrator for questions regarding this issue.  
 

Visit a FusionPage: Click > FusionPage name 
 

FusionPages and Teachers  
These two sections provide direct links to all of the FusionPages that you are a member of, such as 
classrooms, clubs and athletic teams, and to the profile pages of each of your teachers.  

FusionPages 
 

From Personal Dashboard 
 

Click FusionPages > Click FusionPage Title 
 

From FusionHome 

 
Click > FusionPage Title 

 

 



 

Last Updated: June 11, 2010 9 

Teachers 
 

From Personal Dashboard 
 

Click Teachers > Click Faculty/Staff Members name 
 

From FusionHome 
 

Access a specific teachers profile page: Click > 

Teachers Name 

 

 
Fusion Home 
This link provides direct access to your Fusion Home Page, which contains access to: your profile, discussion 
topics posted by your teachers, message center, direct links to your classrooms and your teacher’s profiles, 

and your participation report. 
Click > Fusion Home  

 
My Profile 
Your code name is composed of a color and an animal.  
This code name is used instead of your real name to 

protect your actual identity from other students and 
the general public. Your parents, teachers and 

administrators will be able to see your actual name.  

 
This code name is randomly generated when your 

accounts is created, and will be unique to your school. 
Once you comment on a blog, you will not be able to 

change your code name.  
 

Change your code name prior to your first post:  
Click> Click here to pick a different code name>  

 

Click > Color  
 

Click > Animal 
 

Animal and Color combinations that are no longer 
available will be grayed out.  

 
Click > Close Window to save your choices  

 

Please note: Once you have added a comment to a 
Discussion topic, you cannot change your code name.  
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Home 
The Home link will take you back to your FusionHome 
page when you are viewing your Participation Report 

and Message Center 
 

Click > Home 

 
Participation Report  
Students are encouraged to participate online with SchoolFusion.  Whenever a teacher (also known as 

Faculty/Staff) posts a Discussion Topic, such as a Blog, Slideshow, Podcast, or Video or Wiki, you are able to 
enter into discussions about that post in a safe and productive manner.  The more you participate, especially 

in a positive manner, the more freedom you are given to post and remark on the comments of your teachers 
and other students. This is called clout and confidence. Until you have earned enough clout and confidence to 

post freely, all of your comments are moderated. Comments will not appear within a comment thread until 
they have been approved.  This right is earned by multiple postings, and applying awards to the comments of 

others, and by receiving these awards for their own comments.  

 
Participating in Discussion Topics is discussed further in this document.  
Participation Report 

 
Click > Participation Report  

 
Participation Level 
 

Participation level is a measure of your actively over the past 
sixty days. In order to earn the highest level of participation 

stars, you must actively participate in all five levels of 
criteria.  

 
This rating is increased based on five criteria:  

 Writing a lot of useful comments  

 Rating the comments of others accurately  
 Replying to the comments of others  

 Receiving replies to your comments 
 Keeping it clean, by being a good netizen.  

 



 

Last Updated: June 11, 2010 11 

Badges Earned 

 
Based on the awards given by members of the community, 

you can earn badges. Badges are earned as your comments 
are given awards. Badges are displayed to other members of 

the community when a code name is hovered over.  
 

The badges that can be awarded are:  
 Beginner – A user new to the system who has not 

earned initial trust yet.  

 Expressive - The expressive are not shy in sharing 
their personal or emotional experiences. They can bring 

gravity to otherwise abstract and impersonal topics. 
This badge is earned by posting passionate comments. 

 Comedian- A comedian is witty and clever. They 
lighten a conversation with polite humor. This badge is 

earned by posting funny comments. 
 Scholar – A scholar is knowledgeable and resource full. 

They often bring new knowledge and experience to a 

conversation. This badge is earned by posting 
informative comments.  

 Supportive – The supportive badge means you are 
very encouraging of others. They recognize and reward 

good participation. They stand up for those being 
unjustly attacked. This badge is earned by posting nice 

comments.  
 Visionary- A visionary sees things in different and very 

often creative ways. This badge is earned by posting 

insightful comments. 
 Philosopher- A philosopher is logical and persuasive. 

They use sound reasoning to debunk bad arguments 
and to support good arguments. Earn this badge by 

posting constructive comments.  

 

Comment Awards Received 
This displays a detailed list of the awards that have been 

given your comments. Both positive and negative awards 
will be displayed.  

 
Rejected Comments  
This lists all of your comments that have been rejected. 

These comments could be rejected for inappropriate 

language, revealing personal information, or a comment that 
is off topic for the Discussion Topic. Please keep reading for 

more information on how to properly participate in a 
Discussion Topic.  

 
Note: This will only appear if some of your comments have 

been removed.   
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Participating In 

This displays a list of all of the Discussion topics that you are 
participating in. The following items will be listed:  

 Discussion Topic Title 
 Number of Comments you have added 

 Number of Replies you have given 
 Numbers of Awards your comments have received.  

 
Go directly to a Discussion Topic:  

Click > Topic Title  

 
Class Quizzes 

The Class Quizzes section allows teachers to create 
interactive timed quizzes for you to complete online. An 

unlimited number of questions can be created and stored. 

The software automatically will keep track of all your scores 
and compile the information. 

  
Take a quiz: Click > Quiz Name > Follow instructions 

on screen 

 

FusionPage Contacts  
The FusionPage Contacts feature allows the teacher to 

provide contact information for you. 

 
FusionPage Description  

The FusionPage Description is a place for the teacher to 
insert some information about that FusionPage.   
FusionPage Files 

The FusionPage Files section allows the FusionPage 
administrator to post handouts and other documents. These 

may be documents created in Word, Excel, PowerPoint or 

PDF documents. 
 

Open a file: Click > File Name  

 
FusionPage Calendar 
The FusionPage Calendar allows the FusionPage 

administrator to post dates on your FusionPage calendar, 
which automatically filters to the personal calendars of all 

the page members. 

Any events that you add to the FusionPage calendar will 

appear on the personal calendar of any FusionPage member.   
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FusionPage Links 

The FusionPage Links section allows the teacher to post links 
to websites that might be helpful for additional information. 

 
Open a link:  Click > Link Title 

 
Team Results 

(This feature is only available in athletic team pages) 
 

Team Results provide a place for the FusionPage 
administrator to post team scores and results. Information 

entered into the feature will appear on the team listing 
page, in a scrolling list of all recent results from the past 7 

days.   
 

Schedule  
The Schedule feature allows the FusionPage administrator to 

post an agenda for the Classroom. 

 
Team Schedule  
(This feature only available in team pages, and only when 

the Schedule feature is activated) 
 

The Team Schedule provides a place for FusionPage 

Administrator to post the team game schedule. 

Scheduled events are automatically added to the team 

calendar, and are therefore filtered out to the member’s 

personal calendars. 

 

Discussion Topics 
The Discussion Topics feature displays FusionTool postings 

from all administrators of the classroom page. These 
postings appear in chronological order.  

 

Access a Discussion Topic: Click > Topic Title  
My Discussion Topics 
This displays all of the public discussion topics, such as blogs, podcasts, slideshows, videos and wikis that 
have been created by your teachers and have been associated with the FusionPages that you are a member 

of. You may participate in any of the Discussion Topics listed on this page.  



 

Last Updated: June 11, 2010 14 

Accessing a Discussion Topic 
Click > Topic Title  
Or 

Click > Enter Discussion 

 

 
Participating in a Discussion Topic 
Within Blogs, Slideshows and Podcasts/ Vodcasts, you can add comments and rate the comments of other 

users. These comments are moderated and will not appear until they have been approved.  
 

You are encouraged to add new comments pertaining to the observations of other users. This creates a real 

life dialog, allowing users to include their own thoughts, and have open discussion with other users. Since 
each user name is coded, there is a freedom to comment without fear of retribution 

 
In addition to replying to existing comments, users can also rate those comments.  Users are first asked to 

designate a comment as good, bad or problematic, and are then asked to further rate a comment based on 
their first comment designation. 

Safe and Responsible Blogging 
The Discussion Topics are considered an extension of the classroom and therefore are subject to these 

guidelines as well as the rules and regulations established at your school. The blog is an extension of the 
classroom, you should not write anything on a blog that you would not say or write in your classroom.  If you 

are ever in doubt about the appropriateness of an item, please ask a parent or teacher. 

 
Here are some specific items to consider: 

 
1. The use of blogs is considered an extension of your classroom. Therefore, any speech that is considered 

inappropriate in the classroom is inappropriate on a blog. This includes, but is not limited to, profanity; 
racist, sexist or discriminatory remarks; personal attacks. 

2. Blogs are used primarily as learning tools, either as extensions of conversations and thinking outside of 
regular class time, or as the basis for beginning new classroom discussions. Either way, be sure to follow 

all rules and suggestions that are offered by your teachers regarding appropriate posting in your class. 

3. Blogs are about ideas – therefore, agree or disagree with the idea, not the person. Freedom of speech 
does not give you the right to be uncivil. Use constructive criticism and use evidence to support your 

position. Read others’ posts carefully – often in the heat of the moment you may think that a person is 
saying one thing, when really they are not. 

4. Try not to generalize. Sentences that start with words like “All” (e.g., “All teachers,” “All administrators,” 
“All liberals,” “All conservatives”) are typically going to be too general. 

5. Blogs are public. Whatever you post on a blog can be read by anyone and everyone on the Internet. Do 
not post anything that you wouldn’t want your parents, your best friend, your worst enemy, or a future 

employer to read. 
6. Blog safely. NEVER post personal information on the web (including, but not limited to, first names, last 



 

Last Updated: June 11, 2010 15 

names, personal details including address or phone numbers, usernames to other sites/social networks, 

or online games, or your initials). (Note: The advice to not use your first and/or last name is for your 
protection. Teachers may choose to use their last names for their posts/comments.) Do not, under any 

circumstances, agree to meet someone you have met over the Internet. 
7. Linking to web sites from your blog or blog comments in support of your argument is an excellent idea. 

But never link to something without reading the entire article to make sure it is appropriate for a school 
setting. 

8. Use of quotations in a blog is acceptable. Make sure that you follow the proper formatting and cite the 
source of the quote. 

Add a Comment to a Blog, Slideshow, or Podcast/ 

Vodcast:  
Click> Add Comment > Add your comment > Click > 

Submit  

 
Remember that your comments will not appear until they has 

been approved by an administrator, or you have earned 
enough clout to post freely  

 
Rating Comments 
Any award given will affect the clout of the user who submitted the commented, in either a positive or 
negative manner. The clout of the award giver can also be affected, if they designate a comment as bad or 

inappropriate, and that comment is later found to be positive by an administrator, the awards givers clout 
will decline.  

Rate a comment : 

Click > Thumbs Up or Thumbs Down > Click  > Award >  
Click > Keep 

 
Good comments can be insightful, funny, positive, but in 

general they should add to the conversation in a constructive 

manner.  A good comment does not necessarily mean that the 
reader agrees with the comment, but that the comment is 

well written, presents a good argument or provides insightful 
information.  

 
Bad comments can be anything negative or inappropriate, or 

displeasing. It does not have to be a bad comment, or 
something that the reader disagrees with, but should be 

marked bad if the comment is presented poorly, or is hurtful, 

or irrelevant.  
 

Problem comments can also be marked. This should only be 
used if the comment contains a name, or other identifying 

information, or is considered to be compromising, or needs a 
revision. Administrators will get a chance to review comments 

flagged as problematic, and give the poster the ability to 
revise the comment.  
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Additional Awards 

Once a comment has been designated as good or bad, further 
awards are available to add to each comment. These 

additional honors help build or degrade a user’s clout level. 
The more positive awards that are given, the faster the clout 

level will rise, and the more negative awards that are give, 
the faster the clout level will fall.  

 
When a good designation is given to a comment, a user 

can also grant more in-depth awards, such as:  

 Insightful - Novel and creative. Not an obvious idea or 
reaction.  

 Informative – Useful, relevant and factual   
 Constructive – Logical. Builds the argument, either by 

correcting or by expanding.  
 Funny – Politely humorous 

 Passionate – Emotionally moving, fiery or personal.  
 Nice – What a nice thing to say. Compliments or 

encourages a good comment by someone else.  

 
Additional awards can also be granted for comments 

marked as bad, for example:   
 Illogical – Presents a logical fallacy. Doesn’t make 

sense.  
 Off Topic – Totally irrelevant to the conversation.  

 Redundant – Repeats what has already been said with 
nothing new added. 

 Not Funny – Tries to be funny, but us instead crude, 

mean spirited or politically incorrect.   
 Spiteful – Not inappropriate, but still mean. Could also 

be obnoxious, rash, immature, etc. 

 
 

 
 

Inappropriate Comments 
When a comment is marked as problematic, you will be asked 

to explain why the comment is inappropriate. Do not use this 
if you disagree with the content of the comment, only if the 

comment is vulgar, hateful, discriminatory, or otherwise 
inappropriate for the audience. This will hide the comment 

until an administrator has reviewed it. Please do not use this 
lightly, as you could be penalized if the administrator 

disagrees with you 
 

Participating in a Wiki 
The SchoolFusion Wiki system has taken the traditional wiki tools and updated them to meet the needs of a 

school environment. You must be a member of a FusionPage to in order to view and contribute to a Wiki.  

A wiki system is a web-based system that allows for the easy construction and revision of a number of 
interlinked topic pages. This results in a collaborative effort to create rich and full pages full of shared 

information. 

Within a Wiki, you will be posting using your real name, not your code name.  

Please note that all additional and page changes are tracked within a wiki, and will be attached to your 
name. Please use caution when participating within a wiki, and follow the Safe Blogging Guidelines.  

Before entering any wiki, you will be asked to agree to the Acceptable Use Policy. 
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 “The wiki is an open environment, meant for true collaboration. Every action taken inside of the wiki is 

tracked and reported to your teacher. By clicking "Accept", you are agreeing to be responsible and only add 
content that your teacher and/or school will condone.” 

Open the Wiki: 

Click the Wiki Title > Accept and enter the wiki 
 

If no content has been added to a topic, a blank page will be 
presented to the user. To create the page to begin typing 

content into the page. 

 

 
Create additional topic pages within the wiki based on 

the content you have entered: 

Highlight the appropriate text > Click > Ab (Internal 
Link) button 

  
This will add double brackets ([[ ]]) around the selected 

words, signaling the system to create a new topic page, and 
when the page is saved will create a link to the new page 

within the current page .  
 

For example SchoolFusion would become [[SchoolFusion]] 

 
Within a wiki page, red links indicate an internal link to a 

page that has not been populated. Blue links indicate a link to 
a populated page.  

 
 
 

 
 

 
 

 

Publish the Page: 

When you have finished adding content to your page, 
 

Click > Save Page 
 

Show Preview: 
Click > Show Preview to display a preview of the page.  

 
This page will not be visible to the public until it has been 

saved.  

 

Reports  
Some SchoolFusion Clients have chosen to display additional information regarding your grades, attendance 

and other pieces of information regarding your school life.  
 

Please note: There options will not be available for all students.  

Online Grades 
 

Online Grades will display grades that have been uploaded by 

your teachers. These grades will be broken down by class.  
 

Click > Reports > Click Online Grades > Click 
Appropriate Tab 

 
Each school determines if and when grades are uploaded. If 

you have questions on the grades that are displayed, please 
contact your school directly.  

 

 
Student Information Center 
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Click >  Reports > Student Information Center 

The Student Information Center might display the following 
information:  

 Attendance Totals 
 Schedule 

 Transcript  
 Discipline 

 
Click > Appropriate Tab 

 

Please note: Your school district has determined what 
information is to be displayed in the Student Information 

Center. If you have questions regarding this information, 
please contact your school directly.  

 

Ask for Help 
The Ask for Help link is any users’ first stop for questions or issues that you have and is available to all 
logged in users. A user can search through Frequently Asked Questions (FAQs), submit a Support Ticket or 

offer SchoolFusion a suggestion.   

Access Ask For Help 
 

 Click > Ask for Help   
FAQ 
 
Click > FAQ 

 
The FAQ link takes you to the SchoolFusion knowledgebase 

which can be searched by keyword or browsed by category.   
 

Create A Tech Support Ticket 
 
Click > Create a Support Ticket 

 

Submit a Support Ticket when you need assistance with an 
issue that was not addressed in the FAQ’s. 

 
The Subject line and the Description must be filled in.  Try 

to include as much detail as possible. 
 

Use the Browse button to attach a file to the ticket. 
 

When completed, Click > Submit New Support Ticket. 

 
The Support Ticket will be routed to the Website 

Administrator.  The Website Administrator will either respond 
to the ticket or escalate it to the SchoolFusion Support. 

 
Please note: This option is not active for students on all sites. 

If you need assistance, please contact a school administrator.  

 

Recent Activity 
Recent Activity displays links to current activity accouring on your user acccount. This is the same information 

that is sent in the Recent Activity email, and may include :  
 Homework assignments 
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 Class announcements 

 Class/Group calendar events 
 The addition of new Class/Group files 

 Blog entries by teachers of groups that the user is a member of 
 Responses to any comments that the user has posted 

 Grades 

Recent Activity 
 

View an item in the Recent Activity menu: Click > Item 
title 

 
See all items in your recent activity: Click > More 

 
 


